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Class Description 

In this hands-on lab you'll gain the skills you need to begin getting the most out of 
your Revit Material Libraries. Learn to create and manage material libraries and 
share them with any Revit project or family. Create custom procedural materials 
and even image-based materials from your own photographs. 
 
Key Learning Outcomes:  

1. Learn to manage your Revit material libraries and create custom ones that 
you can share between projects and families  

2. Learn to create custom materials using the vast array of built-in settings 
and controls  

3. Create custom materials from your own photographs and learn to make 
the images completely seamless 

 

About the Speaker: 

Paul Aubin is the author of many Revit book titles including the widely 
acclaimed: The Aubin Academy Mastering Series: and the all new Renaissance 
Revit and Revit video training at www.lynda.com/paulaubin. Paul is an 
independent architectural consultant providing Revit® Architecture 
implementation, training, and support services. Paul’s involvement in the 
architectural profession spans over 20 years, with experience in design, 
production, CAD management, mentoring, coaching and training. He is an 
active member of the Autodesk user community, and is a high-rated repeat 
speaker at Autodesk University, Revit Technology Conference and a national 
speaker at the BIM Workshops. His diverse experience in architectural firms, as a 
CAD manager, and as an educator gives his writing and his classroom instruction 
a fresh and credible focus. Paul is an associate member of the American 
Institute of Architects and a member of the Institute of Classical Architecture. He 
lives in Chicago with his wife and three children.   
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Materials 
The primary function of materials in a Revit project is to establish the graphical 
characteristics of a physical element in the model. But materials are capable of 
doing much more than this. In additional to their graphical characteristics, a 
material can define the structural and thermal properties of an element as well. 
You can also associate meta data to a material to make them more useful for 
the information part of your BIM.  
One thing that is little more challenging to achieve with Revit materials is 
defining finishes. For example, a concrete floor might have a clear coat finish. A 
gypsum board wall might be painted or have wall covering. If you wish to 
convey such finishes in your model, you will need to create materials specifically 
for that purpose and apply them to separate “finish” elements. You can also use 
the paint tool to finish elements.  
While I raise this issue here, I do not want to dwell on it in this session. The subject 
of materials vs. finishes could be a session all its own. In this session I will be 
focusing instead on techniques to create and manage materials. If you choose 
to create “Finishes” as separate materials, you really just need to implement a 
naming convention to distinguish them from your physical materials, but all of 
the techniques we will discuss would still apply. So, with that, let’s dig in.  

Interface 
The “Material Browser” dialog is your primary interface for all material related 
operations. In addition to the “Material Browser” you will also occasionally work 
with the “Asset Browser.” Let’s take a look at the major interface elements of 
these two dialogs starting with the “Material Browser” (see Figure 1). You can find 
the “Material Browser” tool on the Manage tab.  
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Figure 1—The Material Browser 

As you can see in the figure, the “Material Browser” has three main areas or 
“panes.” The top left is a list of the materials in the current project. At the top of 
the list is a search field that you can use to find specific materials quickly. It is a 
live search that instantly filters the list as you type. You can search on both the 
names of materials and any keywords associated with them. So if you type in 
“br” you will see not only brick materials but Oak Flooring might show up too. This 
is because the Description of Oak Flooring is: “Quercus Rubra” which contains 
“br.” Naturally the more letters you type, the more specific a search will run and 
therefore a more filtered list with fewer results.  
When you select a material in the list, its properties will appear on the right side 
of the dialog in the editor pane. This pane can have up to five tabs across the 
top: Identity, Graphics, Appearance and possibly Physical and Thermal. Some 
materials will not have Physical or Thermal properties, so these tabs would be 
missing. The Identity tab is used to input meta data for the material. You can add 
a description, class, comments, keywords, product information and even 
keynotes. Adding useful information here makes your materials more powerful in 
tagging, scheduling, searching and exporting. The Graphics and Appearance 
tabs control how the material will look. Graphics controls non-rendered 
appearance and rendered appearance (including Realistic shading) is 
configured on the Appearance tab.  



Managing and Creating Custom Revit Materials  
Paul F. Aubin, www.paulaubin.com 

  

 Page 4 of 32 

If your material has physical (as in structural) characteristics, those properties will 
be assigned and configured on the Physical tab. Thermal characteristics such as 
conductivity, density, porosity and reflectivity are configured on the Thermal tab.  
If one of the tabs is missing, there will be a small plus (+) sign that you can click to 
add any missing assets (see Figure 2). 

 
Figure 2—Add missing assets in the Material Browser 

The third pane of the “Material Browser” is below the list of materials and may be 
hidden in your copy of Revit. You can display the Material Library pane by 
clicking the small Show/Hide Library Panel icon near the top of the dialog, just 
below the search field. The library panel is divided horizontally into two panels. 
You can also hide or show the library tree panel if you choose. Use the library 
panel to load material libraries and access additional materials not currently 
loaded in your project (see Figure 1 above).  
 
The “Asset Editor” is a separate browser window that gives access to assets from 
external libraries installed with the software. On the Manage tab, click the 
Additional Settings drop-down and then choose: Material Assets.  
This will display the “Asset Editor” which will appear as an empty dialog at first. 
Click the small icon at the bottom right to open the “Asset Browser” and access 
various assets available in the library. Depending on which options you installed 
with Revit, you may have several libraries loaded (see Figure 3).  

 
Figure 3—Asset Editor and Asset Browser 
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After you find an asset you like, you can click the small icon that appears to the 
right to add it to the editor. There you can edit the properties of the asset if you 
wish. Apply your changes and then click OK to dismiss.  

Creating New Materials 
Now that we have a brief introduction to the material interface, let’s create 
some custom materials. You can create a material in a couple ways. You can 
duplicate an existing one and modify it, or you can create a new material.  

Create a Simple Material 
Let’s start with something simple. Depending on the stage you are at you’re your 
project design, you can often suggest materiality with simple materials of 
different colors. This is the easiest material to make.  

1. Launch Revit and open the file: 01_Simple Material.rvt.  

2. On the Manage tab, click the Materials button.  

 At the bottom-left corner of the dialog, click new material icon and choose: Create New Material.  

This will create: Default New Material.  

 Right-click Default New Material and choose: Rename. Name it: White Foam Core.  

3. On the Graphics tab on the right, in the Shading area, click the color swatch and then choose solid white. 
Click OK to accept the color and then click OK again to dismiss the dialog (see Figure 4). 

 
Figure 4—Create a new material assigned to solid white 

There are many ways to apply a material. Let’s apply this one as the default.  
4. On the Manage tab, click the Object Styles button.  

 Scroll down and next to walls, click the browse button in the Material column.  

 Choose your new White Foam Core and then click OK. 

OK. Really basic stuff to be sure. And I am pretty sure you knew how to do that 
much already. There are of course other settings on the Graphics tab.  

5. On the Manage tab, click the Materials button again.  

Beneath the color we just set, we can add transparency if we need to. Surface 
pattern is displayed when you look at the element and cut pattern when you 
cut through this material in either section or plan. These patterns display in non-
rendered views.  
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 Click the Identity tab.  

There are many data fields here. Input as many of the values as you can. As 
mentioned above, this will aid in searching and you will be able to include most 
of these values in schedules and even in material tags. Let’s take a look at one 
of the settings: Class.  

6. In the Descriptive Information area, click the Class drop-down and choose: Plastic.  

This provides a grouping for your materials. Try to choose the class that best suits 
the type of material you are making.  

7. In the material list at the left, click the drop-down at the left just beneath the search field. Choose: Plastic.  

Notice how this filters the list of materials to only include those that are 
designated as: Plastic. The really cool thing about this setting is that you can 
type in your own custom Class. Just click in the field and type it.  

 In the Class field, type: RTC. Then choose this as the filter on the left (see Figure 5).  

 
Figure 5—The Class setting lets you group and filter your list of materials 

8. Set the filter back to <All> before continuing.  

Go ahead input test values in the Description, Comments and Keywords fields. 
You can put more than one keyword separated by commas. Then on the left, try 
searching for each of the values you typed in. The list will filter again, but this time 
showing materials that contain these values. So can search on any of the 
descriptive information and the name of the material. So this will make working 
with large lists more manageable.  

Appearance Tab 
Now that we have a good understanding of what we can do on the Identity 
and Graphics tabs, I am going to focus our attention in the remaining examples 
on the Appearance tab.  

1. Clear any searches and be sure the filter is set to: <All>.  

2. Make sure that White Foam Core is selected and then click the Appearance tab.  
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Notice that the color here is a medium gray not white. Also notice that most of the 
available settings are not enabled (they are unchecked). So if you were to render 
this material, the results would be mostly unsatisfactory.  
Look at the top of the Appearance tab, to the left. You will see a small hand icon 
with a zero above it. (Next to it the name of the Asset appears: Generic (10) in 
Figure 6).  

 
Figure 6—Assets must be carefully managed to avoid unexpected results 

When you pause your mouse over the hand icon a tooltip tells you that the asset 
is only being used by the current material. This is also indicated by the zero 
above it. In other words, there are zero assets also using this asset. If the number 
read 1, it would mean that one other material is using this asset.  

3. Right-click White Foam Core and choose: Duplicate. (You can also access duplicate from the same pop-up 
at the bottom left where we accessed Create New Material).  

 The name will still be in rename mode, type in: Blue Paint and then press ENTER.  

(Note: if the title bar at the top of “Material Browser” still says “White Foam 
Core(1)” after you rename, select a different material in the list and then 
select Blue Paint again to update it).  

Take notice of the small hand icon now. It will now have the number 1 above it 
indicating that the asset is shared with one other material. In my case, this asset 
is called: Generic(10). Yours may vary, but whatever the name, it will be shared 
by both the Blue Paint and White Foam Core materials at the moment. We need 
to address this before continuing. If you make any changes to the appearance 
asset right now, it will change on both materials. In some cases, this may be what 
you want, but in this case we want each material to reference separate assets.  
I should note that if you create a new material like we did at the beginning for 
White Foam Core, the new material will create a new asset too; called: 
Generic(11). Try it if you like! But just be sure to reselect Blue Paint before 
continuing. So why wouldn’t you always use: Create New Material instead of 
Duplicate? It really depends. Sometimes you want a material that is very close in 
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configuration to an existing one. Duplicate is useful for that. Otherwise, new is 
probably better. There is an easy way to duplicate the asset after duplicating 
the material. Let’s do that now.  

4. At the top-right corner of the editor pane, click the small duplicate asset icon (see the left side of Figure 7). 

 
Figure 7—Duplicate and rename the appearance asset 

Simply clicking this icon will create a new asset for this material. Notice that the 
name will be something like: Generic(12) and that the number above the hand 
icon will change to zero. This is because the newly copied asset applies only to 
this material now. This is really important to do when duplicating materials or you 
run the risk of having your edits affect many materials at once.  
It is also a good idea to rename the asset while we are here.  

5. Expand the Information grouping directly beneath the preview image.  

 In the Name field, replace the existing name with: Blue Paint.  

Notice that there are additional meta data fields here. You should also input 
some values here as well. But just why are there two description and keyword 
fields? Well, the ones we edited above applied to the entire material definition. 
In other words they were the description and keywords for this Revit material. 
However, the current description and keywords apply only to the Appearance 
asset. This may seem strange until you consider that assets can actually be 
shared between projects and even to other Autodesk products like AutoCAD or 
Showcase. We will discuss this further below. So take the extra moment to input 
some data here as well. Finally, since, we have named this: Blue Paint, if you like, 
you can return to the Identity tab and change the Class to: Paint. You can also 
just add Paint to the keywords instead. It is up to you.  
 
So now that we have duplicated, renamed and added data, we should 
probably make our Blue Paint actually blue.  

6. In the Generic grouping, click the Color swatch and choose a nice blue color and then click OK.  

By default, the color assigned to the appearance and the color on the Graphics tab are not the same. 
Typically you will want them to be however. So let’s take care of that next.  

 Click on the Graphics tab.  
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 Check the “use Render Appearance” checkbox and then click OK (see Figure 8).  

 
Figure 8—Assign a color and link the Graphics tab to the Appearance 

In this case, this will use the same color number on Graphics that is used on 
Appearance. However, if you use an image instead, then this checkbox will take 
an average color from the bitmap image and use it for the Graphics color. We’ll 
see this below.  
There are three groups of walls in the file. Each group uses a different wall type. 
Let’s assign our new Blue Paint material to one of these types.  

7. Select any wall onscreen, and then on the Properties palette, click the Edit Type button.  

 Edit the Structure and then assign the Blue Paint material to the Structure layer. Click OK three times to see 
the result.  

So once again, this is not a very sophisticated material. But please keep in mind 
the importance of the procedures we followed to ensure that we were editing 
the correct material and asset. Furthermore, the meta data we added is also 
quite valuable for ongoing project management.  
(Note: if all of your walls turned blue, you missed the step where we duplicated 
the Appearance asset. A Catch up file is provided).  

Replacing Assets 
There is a large collection of assets included with the software. The specifics of 
exactly what you have available will vary with your region and the installation 
options you chose. But regardless of the specific collection of assets available to 
you, you can use the following procedure to swap out the assets applied to a 
material with another one from the library.  
CATCH UP! If you get behind, look for these boxes. I have saved versions of the files at various stages of 
completion. You can open the file completed to this point named: 02_Material Assets.rvt.  

You can continue in the same file or open the provided catch-up file.  

1. Open the “Material Browser” and then select the Blue Paint material.  
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2. Click the Appearance tab and at the top click the Replace this asset icon (next to the Duplicate icon).  

This will display the “Asset Browser” dialog. We introduced this dialog above. 
Simply search for an asset and then you can replace the one in the editor with 
the new one. There many kinds of assets, each with their own unique properties. 
For example, there is an asset type for paint. This asset will give more realistic 
results than the generic one we are currently using.  

3. In the Search field at the top, type: paint.  

In the provided “Appearance Library” there are many more assets to choose 
from than the “Autodesk Physical Assets” library. However, you should be able to 
find something acceptable in whatever library have access to.  

 Expand the Wall Paint category and select the Matte category.  

 Select any color you like in the list.  

The color does not matter, as we can change it. 

 On the right side, a small double arrow icon will appear. Click this to replace the current asset with this one 
(see Figure 9).  

 
Figure 9—Replace the asset with a paint asset 

4. Close the “Asset Browser.”  

If you want, you can rename the asset and you can change the color too if you wish. 

Notice that the settings available to the Appearance asset are now different. 
The main grouping is Wall Paint and this is where you can modify the color if you 
like. Also, there is a Finish parameter and an Application parameter. These offer 
many common paint characteristics (see Figure 10). Also take note of the 
description and keywords. Most of the assets from the provided library come 
with these values already filled in. You can of course edit any setting as 
necessary.  
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Figure 10—Edit the Finish and Application to get more realistic looking paint 

Procedurals 
As you can see, using various asset types and simple color settings can give a 
great deal of variety. But this is barely the tip of the iceberg. We can assign 
images to our materials to make more complex and realistic appearance. Images 
can be either bitmap image files (photographs) or procedurals. A procedural is a 
bitmap that is generated with a mathematical formula instead of a photograph.  
CATCH UP! If you get behind, you can open the file completed to this point named: 03_Procedurals.rvt.  

1. Select one of the other walls onscreen. Edit Type and then edit the structure. Finally, click the material 
browse icon to open the “Material Editor.”  

2. At the bottom of the dialog, click the New icon and choose: Create New Material.  

 Rename the new material and call it: Checkerboard Tile.  

3. Click the Identity tab and from the Class drop-down, choose: RTC. Input a Description and Keywords.  

4. Click the Graphics tab and check the “Use Render Appearance” checkbox.  

5. On the Appearance tab, edit the Information:  

 Change the Name to: Checkerboard Tile. Input a Description and Keywords.  

6. In the Generic grouping, click the drop-down next to the Image item. Choose: Checker from the list.  

The “Texture Editor” will open. There are several settings here. At the top you will 
see a preview of a black and white checkerboard. At the bottom you will see 
settings that control the size of this pattern and how it repeats. By default, it is 
one by one and repeats in both directions. Let’s leave all that as-is for now and 
focus on the pattern.  

7. Near the top, click on the swatch for Color 1 and choose a different color. Repeat for Color 2.  

Let’s see what this looks like in the model.  

 Click the Done button, and then OK three times (see Figure 11).  

If your material does not display, make sure shading is set to: Realistic.  
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Figure 11—Add a checkboard pattern to the material 

8. Return to the “Material Browser,” select Checkboard Tile and then click the Appearance tab.  

 Click on the Checker swatch to edit the pattern again.  

So that we can see our results better in the project, let’s increase the size of the tile.  
9. For the Scale, change the sample size to: 4'-0".  

Note: Interestingly, if you are working in imperial units, the “Texture Editor” 
defaults to inches even if the project uses feet.  

10. Leave the “Texture Editor” open and click on the “Material Editor” window to make it active. Then click the 
Apply button to see the change in the model. Click back to the “Texture Editor” to make it active again.  

Let’s just briefly discuss the remaining settings in this texture before continuing.  
Appearance—in addition to the color swatches, there is a setting called Soften. 
This blurs the edge between the two colors making it a soft instead of crisp edge. 
It does not take much. A value of: 0.1 is quite dramatic. Much more than that 
and it starts to look like a solid color. Go ahead and try it if you like, just be sure to 
set it back to zero before you continue.  
Transforms—we can apply images to other channels in the texture. The most 
common one is Bump or Relief Pattern. We have only this one texture at the 
moment, but if we add a bump pattern, the “Link texture transforms” checkbox 
would make sure that any adjustments to Position, Scale and Repeat would be 
applied to both textures. Without this checkbox, you would have to configure the 
settings the same manually in two different editors. If you think you might add a 
Bump, you should check this box. It won’t hurt anything if there is no Bump applied.  

11. Check the “Link texture transforms” checkbox. 
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Position—you can offset the pattern in the X or Y directions as well as apply 
rotation. Feel free to experiment with these, but reset to zero offsets and rotation 
before continuing.  
Scale—we have already adjusted the scale of the sample size above. However, 
you may have noticed that the two settings changed together. If you want to 
set Width and Height separately, click the small link icon to the right to disable it.  

12. Click the small link icon next to Width and Height, change the Width sample size to: 8'-0" and then in the 
“Material Browser” window click the Apply button.  

Repeat—two choices here: Tile and None. Most of the time you will want Tile 
which simply repeats the texture across the surface. If you are creating a 
material with an image you don’t want repeated, you can change it to None. If 
you do this, make sure that you also set the scale carefully. For example, I 
recently created a flag in the family editor. I created a material using a bitmap 
image of the American flag and then here, set tile to none and made the scale 
match the size of the flag.  
CATCH UP! If you get behind, you can open the file completed to this point named:  
04_Nested Textures_01.rvt.  

Using Nested Textures 
At this point, if you have been following along, your texture should have an 
elongated rectangular proportion and two colors. Take a closer look at the two 
color swatches above. There is a small drop-down next to each color. With these 
dropdowns, we can add nested textures!  

If necessary, reopen the “Material Browser,” select Checkerboard Tile and then click the Appearance tab.  

1. Click the dropdown next to Color 1 and then choose: Gradient.  

The “Texture Editor” will change to show the properties of the gradient map. By 
default, we get a linear gradient with three colors (black, gray and white) 
equally spaced. When you have nested textures, there will be a dropdown at 
the top just beneath the preview image where you can navigate up and down 
the tree.  
To adjust the colors, click the small node indicators and then change the color. 
You can drag the node in the middle to increase or decrease the progression 
between it and the colors at the ends. You can also drag the middle node away 
from the ramp and release to remove it. You can click the two nodes at the 
ends to change their colors, but you cannot drag them or remove them. The 
middle node position can also be adjusted numerically using the Position field 
(see Figure 12).  
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Figure 12—Add a nested gradient texture to one of the colors 

Undo and Cancel—If you make any adjustments you don’t like, there 
is no undo. But you can cancel the “Material Browser” and then 
reopen it to try again. Any changes made will be lost when you 
cancel. So while it is encouraged to experiment, it will take some 
time to get used to lack of undo. I recommend making changes 
slowly and when arrive at a change you like, close the “Material 
Editor” with OK and save your file. Then come back into the editor 
and continue. This will be a little inconvenient, but not as much as 
pressing ESC in frustration only to realize that doing so means you 
have lost everything since you entered the Material Editor! 

Take a look at the preview shown back in the “Material Browser” for the Checker 
bitmap. Notice that the gradient is being repeated four times within the square 
on the left (see the left side of Figure 13). This is because the size of the gradient 
bitmap is currently using the default of: 1'-0". Let’s change it.  

2. Beneath Scale, set the Width to: 8'-0" (see the left side of Figure 13). 

Notice that the gradient is actually applied across two rectangles of the 
checkboard before it repeats. This is because the checkerboard includes two 
bays in each direction. So if you want to have a full gradient in each rectangle, 
you will need to adjust the scale a bit more. We need to unlink the gradient to 
make it rectangular to match the proportion of the checkerboard and then set 
the sizes to half as big so that we get two repeats for every one checkboard.  
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 Beneath Scale, click the link icon to unlink, set the Width to: 4'-0", set the Height to: 2'-0" and then click 
Apply (see the right side of Figure 13). 

 
Figure 13—Adjust the sizing to make the tiling match the checkerboard 

Naturally we could make further adjustments to scale and rotation and get 
some interesting affects. You are welcome to experiment further. For example, 
try some of the settings shown in Figure 14. 

 
Figure 14—Try variations of Width, Height and Rotation to get many interesting effects 

Meanwhile, let’s adjust the colors to choose something a little bit more 
interesting than basic black and white. There are three colors. So to edit Color 1 
(currently black), click the first node marker, then click the color swatch.  

3. Make sure node 1 is selected (Color 1) and then click the color swatch next to Color 1. Choose a new color 
and then click OK.  

 Repeat for the other two nodes.  

If you would prefer to only have two colors, drag the middle marker off of the ramp and release. It will be 
removed. Alternatively, you can drag it left or right to have blend differently with the start and end colors.  
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If you want to experiment further, feel free. Notice the choices on the Gradient 
Type dropdown. Furthermore, when you combine them with the choices on the 
Interpolation dropdown, the possibilities are nearly limitless. I have included a 
few examples here (see Figure 15). 

 
Figure 15—The possibilities with gradients are nearly limitless 

4. Once you are satisfied with your experimentation, click the OK button in the “Material Browser” and then 
save the file.  

Adding More Nested Textures 
There is so much more we can do with nested textures, both procedural and 
bitmap. We are going to look at bitmaps below, but let’s do one more example 
with procedurals.  
CATCH UP! If you get behind, you can open the file completed to this point named:  
05_Nested Textures_02.rvt.  

If necessary, reopen the “Material Browser,” select Checkerboard Tile and then click the Appearance tab.  

1. Click the dropdown next to Color 2 and then choose: Marble and then click Apply.  

The results will not be that spectacular. But try varying some of the settings.  
2. It will take some trial and error, but make adjustments to the colors, Vein Spacing, Vein Width and rotations 

(see Figure 16).  

You can try adjusting the offsets too, but I find that this makes the seams at the 
tiling very noticeable. So I would recommend against it.  
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Figure 16—Vary some of the rotation settings, colors and vein settings to get better results 

3. Click OK to dismiss the “Material Browser” dialog.  

4. Select the remaining white wall in the model, edit its Type Properties and edit the material assigned to the 
structural layer.  

5. Checkerboard Tile will be selected automatically.  

 Right-click Checkerboard Tile and choose: Duplicate. Name it: Checkerboard Tile Option 2.  

Remember that the appearance asset is still the same as the original. So any 
changes to this material would affect the original as well.  

6. On the Appearance tab, click the Duplicate icon at the top to copy the asset. Rename it if you like.  

7. At this point, if you want to see everything in the view, you can OK to dismiss all dialogs, save the file and zoom 
the window so you have a good view. Then reopen the “Material Browser” and click the Appearance tab.  

Let’s leave the top level map set to a checker pattern, but change out the 
nested maps.  

8. Click on the Checker swatch to edit it. 

9. Next to the Gradient swatch, click the dropdown and choose: Tiles.  

With the Tiles procedural, you can create brick and tile patterns. Since we are 
nesting this one, we want to think about the size we have available. The main 
pattern is an 8'-0" x 4'-0" rectangle. So we need to decide how many tiles we can 
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fit in this space. It defaults to a stack bond 4 tiles by 4 tiles. Let’s say we wanted 
to keep it 4x4 but have it fill one rectangle of the checkerboard.  

10. Beneath Tile Appearance, click the color swatch and choose a Tile Color. You can do the same for Grout 
Appearance if you like.  

11. Scroll down and change the Scale settings to: 4'-0" wide x 2'-0" high and then click Apply.  

 
Figure 17—Adjust the nested pattern to fit the available space 

You can adjust the number of tiles in each direction and the scales to get 
different patterns. Let’s assume that we wanted to use standard (US) sized bricks. 
This would mean that in our 4'-0" width, we can fit (6) 8" bricks across by (9) 2 2/3" 
tall bricks.  

12. At the top, change the Tile Count to: 6 per row and: 9 per column. Apply to see the change.  

Well what about the bond? If you open the Type dropdown, you will see that we 
have several bond type to choose from (see Figure 18).  

 
Figure 18—Try various bond patterns 
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Depending on the type you choose, the various settings below will activate. For 
example, when choosing either the Fine Running or Fine Stack Bonds, this will 
activate the Row and Column Modify settings. If you pause your mouse over any 
of these settings a detailed tooltip appears to explain their function. So please 
feel free to experiment further.  
But here is the really interesting thing about nested textures. You can nest more 
than one level deep! Let’s try it.  

13. Set the bond type back to: Stack Bond.  

14. For the Tile Color, click the dropdown next to the color swatch and choose: Waves. 

 For Color 1, choose something other than black.  

 For the Grout Appearance, increase both the Horiz and Vert Gap Width settings to: 1" each.  

 Click on the dropdown next to the color swatch and then choose: Noise. 

So we are now nested three levels deep. Let’s move back up to the top of the 
tree and make one last change. Using the dropdown just below the preview 
image at the top, you can jump to any level of the tree you want. Let’s change 
the Marble to something else.  

15. Beneath the preview at the top, click the dropdown and then choose: Checker from the navigation list to 
return to the top level.  

16. Click the dropdown next to Marble and choose: Image.  

A browse window will open where you can select an image file.  
 In the Textures folder, choose: RTC Logo.png and then click Open. 

 Beneath Scale, click the link icon to unlink, set the Width to: 4'-0", set the Height to: 2'-0" and then click 
OK to see the results.  

 
Figure 19—Replace the marble texture with a bitmap image 

On the right side of the figure, one last modification is shown. Try setting the 
Soften value to: 0.1. This will soften the edge between the tiles of the top level 
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checkboard and have the logo blend into the tile pattern beyond. All of the 
examples we have explored so far are just the tip of the iceberg. There are so 
many more possibilities. You are encouraged to explore further.  
 
If you would like to learn more about each of the procedural maps, visit this link 
in the Autodesk help: 
http://help.autodesk.com/view/RVT/2016/ENU/?guid=GUID-B07D217E-3F11-43E6-
B37A-5B5F0FAC9D38  

Creating Materials with Images 
While many of the previous examples offer some compelling ways to create 
custom materials, by far the most common way to create custom images is by 
using a tiled image file. The concept is quite simple. Instead of using a solid color 
or a procedural texture, we load an external bitmap image instead. Revit 
supports all of the most popular file formats like: JPG, PNG, TIG, GIF and many 
more. You can access images from nearly any source: files provided with Revit, 
downloaded from the Internet or even taken with your own camera. In the next 
couple exercises, we will look at a few examples of using image files to create 
custom materials.  

Working with Seamless Textures 
When you use an image file on a material, it will be tiled along the surface in 
much the same way as the procedural textures explored above. This means that 
you will typically want the image to be “seamless.” A seamless image will have no 
noticeable seams when it is repeated. Some images are more successful than 
other at this and even in the best images if you look hard enough you can often 
spot the seam. So the biggest challenge is finding good images that adequately 
conceal all seams and look like a believable continuous material. So what better 
place to start than with an image by the master of tessellation: M.C. Escher.  
CATCH UP! If you get behind, you can open the file completed to this point named:  
06_ Seamless Texture.rvt.  

1. Open the “Material Browser,” and at the bottom left corner, click the new icon and choose: New Default 
Material.  

2. At the bottom of the dialog, click the New icon and choose: Create New Material.  

 Rename the new material and call it: Escher Pattern.  

3. Click the Identity tab and from the Class drop-down, choose: RTC. Input a Description and Keywords.  

4. Click the Graphics tab and check the “Use Render Appearance” checkbox.  
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5. On the Appearance tab, edit the Information:  

 Change the Name to: Escher Pattern. Input a Description and Keywords.  

6. In the Generic grouping, click the drop-down next to the Image item. Choose: Image from the list (you can 
also click in the empty white swatch instead).  

 In the Textures folder, choose: Lizards.png and then click Open.  

 Click on the image swatch and then in the “Texture Editor” check the “Link texture transforms” checkbox.  

7. Click OK in the “Material Editor” to finish.  

8. On the Modify tab, on the Geometry panel, click the Paint tool. 

 Paint the new Escher material onto one of the top surfaces of one of the floors in the model (see Figure 20).  

 
Figure 20—Apply the new material with the paint tool 

Create a Seamless Texture 
Now Escher was the master of seamless textures. I wonder how he would have 
liked Revit? Unless you can tap into your inner Escher, it can be tricky to make a 
texture seamless. Particularly because so many of them start from photographs. 
Believe it or not, making the photo seamless is the easy part. Taking a good 
photograph is much harder. I have provided a few samples with the dataset, 
but I must admit they are mediocre at best. I shot mine on my iPhone. The 
trouble is that you need to shoot the image head on and have VERY even 
lighting for it to give good results. If the lighting varies a little from one side of the 
image to the other, it will be hardly noticeable in your view finder and onscreen. 
But once you tile it on a surface, the banding across the image will jump right 
out at you! So, now that you are forewarned, let’s go through the process.  
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The first thing you need is a photo. You can download it or take it on your digital 
camera. As I said, I took mine using my iPhone. Better cameras, and better 
photographers will give better results.  
Next, you need an image editing program. I normally use Photoshop. But there 
are free alternatives out there and here in the lab we will use paint.net. If you 
would like to learn more, you can visit:  
http://www.getpaint.net/download.html 
We will also be using a plugin to help us make the seamless texture. Info for it is 
here: 
http://forums.getpaint.net/index.php?/topic/4591-seamless-texture-maker-
ymd100718/?hl=seamless 
Both of these are installed here in the lab.  

1. Launch paint.net.  

2. From the Textures folder, open the file named: Wood_Floor.jpg.  

When you first look at this photo, it looks pretty even in tone. But as we will see, 
the lighting varies quite a bit from top to bottom on the image (see Figure 21).  

 
Figure 21—An image the looks fine can actually have large variation in lighting 

I have provided a slightly retouched version of this image. Let’s open that one 
instead.  

3. From the Textures folder, open the file named: Wood_Floor_Corrected.jpg.  

There is one other issue with this image. There are very pronounced seams 
between each board. That is part of the character of this flooring material. 
However, both of the boards at the right and left of the image are missing this 
seam. So let’s crop the image to remove one board. We want to crop as close 
to the seam on the neighboring board as possible.  

4. In the toolbox at the left, click the select rectangle tool, drag a box around the part of the image you want to 
keep.  
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 From the Image menu, choose: Crop to Selection.  

Now we’ll run the plug-in effect to make the seamless texture.  
5. From the Effects menu, choose: Distort > Seamless Texture Maker (see Figure 22). 

 
Figure 22—Crop the image and then run the Seamless Texture Maker plug-in 

6. In the “Seamless Texture Maker” dialog, choose the: Only cut option from the menu.  

 For axis of symmetry, choose Horizontal and make sure Flip the selection is set to No (see Figure 22).  

 
This will take the top half of the image and wrap it around and then place it 
beneath the bottom half of the image. We will now have a seam where the top 
edge would meet the bottom edge. If you did nothing else to this image, this 
seam would appear when tiling the image in your materials. (If you are using 
Photoshop, the equivalent command is the Offset filter). Using the clone tool, we 
need to paint this seam out as best we can. This is tedious work and can be 
difficult to get good result if you are not patient. I rarely spend as much time as I 
should on this task and the results show! So if you want good results, you need to 
put in the time. Fair warning!  

7. Zoom in on the seam.  
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8. In the toolbox, click the Clone Stamp tool.  

Some options appear across the top (like the Options Bar in Revit).  

 Choose a Brush Width of about: 45 and the Hardness about: 25%.  

Cloning works the same here as it does in Photoshop. You first click the area you 
want to sample and then you paint with that sample. The brush will follow along 
on the image creating copies of nearby pixels to paint over the hard edge seam 
we have. To set your sample CTRL + click in paint.net, ALT + click in Photoshop.  

9. Hold down the CTRL and then click an area you want to sample. Near one of the board joins is probably best, 
just above or below the seam.  

 Move over the seam area and begin painting (see Figure 23).  

 
Figure 23—Use the clone tool to paint out the seam 

10. Resample as necessary as you move along to get better results.  

 When you are done, save the image and then close paint.net.  

CATCH UP! If you get behind, you can open the file completed to this point named: 
Wood_Floor_Corrected_FIN.jpg.  

Create a Material using the Custom Texture 
The process to use the image is exactly the same as the Escher image above. 
The only difference is choosing our editing image instead.  
CATCH UP! If you get behind, you can open the file completed to this point named: 07_Custom Image.rvt.  

1. Following the same steps as in the “Working with Seamless Texture” topic above, create a new material.  

2. Assign the new seamless texture to it.  

3. Set the Width to: 19 1/2" and the Height to: 17 1/2".  

4. Assign it to one of the other floor elements in the model.  

In realistic shading, we are seeing that the color variation in this image is a bit 
too great. There is a very noticeable repeat because one of the boards has a 
greenish tint to it. This is a common issue when creating seamless textures and it 
gets back to issue I mentioned above about taking a good photograph to 
begin with. Even the most talented Photoshop artist can only do so much with a 
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bad photo. So, now that you have the process, I leave the hard part to you: 
mastering the technique to get good results!  
A really good source for brick textures online is: Acme Brick. Visit:  
http://www.brick.com/architect/tools.htm 
There you can find a standalone tool: The Acme Brick Designer as well as plugins 
for Revit. At the moment the latest release is 2015, but I am sure they will have 
2016 soon. This tool makes seamless brick textures that work very well in Revit 
materials. Check it out! 

Creating a Material from Manufacturer’s Content 
While I was preparing for this session, (well really just after I finished…) I was 
contacted by a fellow speaker here at RTC: Phyllis Robbins. Phyllis is teaching a 
class called: Pen Down/Pen Up: Perfect Patterns on Saturday, Session 3.5 | 4:15 
PM - 5:00 PM. In that session, she will explore how to create repeating patterns 
that you can use in your Revit projects. The patterns can be used for fill patterns 
or even assigned to materials. And that is the tie-in here. So far, I have discussed 
mostly the Appearance tab of the “Material Browser” but have not added any 
surface or cut patterns to the custom materials we have built. Well I won’t be 
discussing how to build your own custom patterns. I will leave that to Phyllis, and I 
highly recommend that you attend her session. So getting back to reason for 
mentioning all this in the first place. Phyllis sent along an image file from a 
manufacturer called Patcraft that create some interesting composite flooring 
materials. She says some of the designers in her firm use these materials in their 
projects and was wondering if I would be covering rotating and aligning custom 
material texture maps with surface patterns. So always up for a good challenge, 
I decided to add another tutorial to the session here to explore exactly that and 
in fact I will use the same files that Phyllis shared with me. So with that 
introduction out of the way, let’s explore creating a custom texture map and 
then aligning it with a custom surface pattern. Thanks to Phyllis for sharing the 
bitmap texture file and the custom Revit PAT file.  
If you completed the exercise above in the “Create a Seamless Texture” topic, 
we will be using Paint.net here again. If you are doing this on your own system, 
you can use Paint.net (see above noted topic for instructions to download and 
install it) or you can use any image editing program you have such as 
Photoshop.  

1. Launch paint.net.  

2. From the Textures folder, open the file named: Patcraft_Start.png.  
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3. From the Layers menu, choose: Rotate / Zoom. In the Roll / Rotate area, in the first field, type: -112.5 
(negative) and then press TAB.  

 The image will rotate onscreen. Click OK to finish. 

 From the File menu, choose: Save As. Name the file: Patcraft_Texture and then click OK. 

The repeat for this material will include one large grey stripe (the carpet) and 
several of the smaller VCT stripes.  

4. Using the selection box, drag from the corner where the black VCT meets the carpet and diagonally up where 
the white VCT meets the carpet on the other side (see Figure 24).  

 
Figure 24—Rotate the image and select the rectangular repeat 

5. From the Image menu, choose: Crop to Selection.  

Now we’ll run the plug-in effect to make the seamless texture.  
6. From the Effects menu, choose: Distort > Seamless Texture Maker (shown in Figure 22 above). 

7. In the “Seamless Texture Maker” dialog, choose the: Only cut option from the menu.  

8. For axis of symmetry, choose Both horizontal and vertical and make sure Flip the selection is set to: No 
(see Figure 25).  

 
Figure 25—Use the Seamless Texture Maker to find the seams 

9. Click OK and then from the File menu, choose: Save As. Name the file: Patcraft_Texture01 and then click 
OK. 
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In the wood floor tutorial above, we used the clone tool. Here we will have 
better success copying sampled areas from the original image instead.  

10. Re-open the file you saved above named: Patcraft_Texture.png.  

11. Use the lasso tool and select a large portion of the black carpet stripe. (Select longer than we need).  

12. Using the icons at the top, switch back to our cropped version of the image. From the Edit menu, choose: 
Paste into New Layer.  

 In the “Paste” dialog that appears, choose Keep canvas size. Drag the layer to position it (see Figure 26). 

 
Figure 26—Copy and paste a portion of the old image into the new one 

13. Repeat to copy and paste the VCT portion of the image. 

You really need to try to make your selections and copy and pastes carefully. 
The key to a seamless texture, is that it must repeat with no noticeable seam. In 
this case you may need to select and delete any portion of the new layers that 
overlap the edges of the image. This will show the original layer through. If you 
don’t do this, we will see the seam at the edges. You can test how well it is 
working by using the Seamless Texture Maker again.  
I found it very difficult to do this well in Paint.net. Paint.net does not seem to have 
a way to do a feathered selection. This makes it difficult to blend the pasted 
layers with the originals underneath. So if you have Photoshop, you can likely do 
a much better job. I have provided two other versions of the texture for you to 
see the progression and to use in the final steps of this exercise:  
CATCH UP! An intermediate version of this image is provided named: Patcraft_Intermediate.png.  

The final seamless version is called: Patcraft_Seamless.png. 

Create a Material using the Patcraft Texture 
The process to use the image is exactly the same as the others above. However, 
in this example, we’ll also add a surface pattern.  
CATCH UP! If you get behind, you can open the file completed to this point named: 08_Patcraft.rvt.  

To save some steps, this file already has a material created and all of the 
information and keywords are already input. We only need to add the texture 
and surface pattern. The material is already painted onto a floor element in the 
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file and there are two callout views of this floor element placed on a sheet for 
comparison. The file should open with the sheet view active.  

14. Zoom in on the two viewports. Open the “Material Browser” and edit the Patcraft material.  

 On the Appearance tab, click the Image tile and browse to the: Patcraft_Seamless.png image file.  

15. Unlink the scale and set the Width to: 6'-11" and the Height to: 4'-0".  

 Under Position, set the Rotation to: 90°. 

16. Click on the Graphics tab. Beneath Surface Pattern, click the tile next to Pattern (currently set to <none>).  

 In the “Fill Patterns” dialog, choose the Model radio button near the bottom and then click the New button 
at the right.  

 In the “Add Surface Pattern” dialog, choose the Custom radio button, for the Name, type: Patcraft Mixed 
Material and then click the Import button. Choose: PatcraftMixedMaterials.pat and then click Open.  

 Back in the “Add Surface Pattern” dialog, click OK.  

17. Back on the Graphics tab, next to Alignment, click the Texture Alignment button.  

 Use the blue arrows to shift the texture until it aligns with the superimposed pattern of lines. Click OK when 
finished. Click OK again (see Figure 27). 

 
Figure 27—Add the custom texture and then create and align a custom surface pattern 

Material Libraries 
As our final topic in this session, let’s discuss material libraries. In the past when we 
wanted to share materials with other users and projects, we relied on Transfer 
Project Standards and copy and paste. Now both of these methods still work just 
fine. But what I want to discuss here are Autodesk Material Library files (ADSKLIB). 
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These are small files that store materials. You can load them into any project or 
family and thereby share your standard and custom materials easily and directly 
within the “Material Browser.” And as a bonus, the ADSKLIB format is supported 
by most Autodesk products. So you can create and share materials from Revit to 
AutoCAD to Navis and Showcase. Very cool.  

Load a Material Library 
To load a material library file, open the “Material Browser” dialog. At the bottom 
of the dialog, click the small folder icon and then choose: Open Existing Library. 
Browse to an existing library to open it. There are a couple built-in libraries 
already loaded. They have a lock icon next to them. Simply browse the folders in 
the libraries and when you find a material you want, hover your mouse over it 
and a small icon (up arrow) will appear. Click this add the material to the current 
project (see Figure 28). Use the same search field at the top of the dialog to 
search both the current document and the libraries.  

 
Figure 28—Load a library and import materials from it 

Create a Material Library 
Creating a material library is as easy as loading one. Use the same tool in the 
“Material Browser” and choose: Create New Library.  
CATCH UP! If you get behind, you can open the file completed to this point named: 09_Library.rvt.  

Let’s start by adding a render path to our options. This will ensure that Revit can 
find our custom bitmap texture files. It is a good idea to store such textures on 
your server in a common location so that the path we add can be the same for 
all users. Then make sure to add the path to everyone’s machine.  

1. From the Application menu, choose: Options.  

2. On the Rendering tab, click the add button. Here in the lab, browse to the Textures folder. In the office 
browse to the network location where your textures are stored.  

This will add a path to this location.  

3. Click OK to save the path.  
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4. Open the “Material Browser” and then at the bottom, click the library icon and choose: Create New Library. 

5. In the dialog that appears, type: RTC for the name and then click Save.  

You will now have an empty library. For our example here we are creating it in 
our dataset folder. But back in the office, you should place it on a network 
server. It is a good idea to add some categories to it to help organize the 
materials within it.  

6. Right-click on RTC and choose: Create Category.  

 Type a name such as: Tile and then press ENTER.  

Notice that a small pencil icon will appear next to the library. This indicates that 
you have it locked for editing.  

 Add any other categories you might need.  

7. At the top of the “Material Browser” from the filter dropdown, choose: RTC.  

Recall above that we created a Class called: RTC. Filtering by this class is the 
easiest way to isolate our custom materials.  

8. Right-click the first material and choose: Add to > RTC > Paint.  

You can repeat for each of the others choosing appropriate categories each time. Or you can drag the 
materials from the top to the appropriate category in the library (see Figure 29).  

 
Figure 29—Add materials to the new library 

You can update the library after creating it by drag and drop as well. Let’s say 
you wanted to add a category for the wood materials.  

9. Right-click the RTC library and choose: Create Category. Type: Wood.  

 Click on the Tile category, drag the Wood Floor material from Tile and drop it on Wood.  

The material will move to the new category.  
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When you are done editing the library, you can release it. This is sort of like 
saving. The library saves in real time. So changes are already saved. But no one 
else can edit the library right now because I am editing it. So by releasing it I 
make it available for others to edit. Keep in mind that anyone can load the 
library and use materials from it without needing to lock it for editing. You only 
need to lock it if you want to change the library in some way (see Figure 30).  

 
Figure 30—Release a library when you are finished editing it 

Sharing Libraries 
To share a library, the recipient just needs access to the ADSKLIB file. For internal 
sharing within your firm, make sure the ADSKLIB file and all required textures are 
on the network server in a common share. Then any user can load the library 
from there.  
To share outside the firm, just send the ADSKLIB and any required textures to your 
recipient. They will need to set up a folder to store things in, add a path to the 
folder as shown above and then load the ADSKLIB file.  
If you have a copy of another Autodesk product like AutoCAD, you can load 
the library in there and easily import the materials (see Figure 31). You might 
have to redirect the path to any bitmaps, but the process should be pretty easy. 
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Figure 31—Our materials can be used in other Autodesk programs like AutoCAD 

That is all we have time for. Thank you very much for attending.  

Further Study 
 
You can find more information and tutorials in my books and video 

training. Please visit my website at: www.paulaubin.com for 
more information on my books.  

I also have Revit video training available at: 
www.lynda.com/paulaubin. I have several courses at 
lynda.com including: Revit Essential Training, Revit Family Editor 

and Revit Architecture Rendering, Advanced Modelling in Revit 
Architecture, Formulas and Curves and many more.  

If you have any questions about this session or Revit in general, you can use the 
contact form at www.paulaubin.com to send me an email.  
Follow me on twitter: @paulfaubin 
 
 
Thank you for attending. Please fill out your evaluation. 


